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File menu commands

The File menu offers the following commands:
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Save All
Save As
Insert File
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UNIX/MAC

to DOS
DOS to
UNIX
Delete
Active File
Print

Creates a new document.

Opens an existing document.

Closes an opened document.

Saves an opened document using the same file name.
Saves all modified documents using the same file names.
Saves an opened document to a specified file name.
Inserts a file into the active document.

Converts the file format from UNIX or MAC to DOS.

Converts the file from DOS to UNIX.

Deletes the disk file associated with the active window and closes the window
losing all changes.

Prints a document.

Displays the document on the screen as it would appear printed.

Set up page headers and footers for printing.
Selects a printer and printer connection.

Exits UltraEdit.



Edit menu commands

The Edit menu offers the following commands:

Insert Page
Break

Eind

Find Next
Replace
Find In Files
Goto

Line/Page
Add Indents

N"

CR/LF's to

Wrap

Convert Wrap
to CR/LF's

Reverse previous editing operation.

Reverse the previous UNDO command.

Deletes data from the document and moves it to the clipboard.
Copies data from the document to the clipboard.

Pastes data from the clipboard into the document.

Selects the line with the cursor.
Selects all the text in the active document.
Inserts a page break at the cursor position.

Search document for a text string.

Repeat the last find.

Search document for a text string and replace it with another text string.

Search files on disk for a text string.

Position the cursor at the specified line or page break (or file position in HEX mode).
Presents a dialog to allow adding indentation to selected rows of text.

Presents a dialog to allow removing indentation from selected rows of text.

Toggles the state of the editing mode for the current window between HEX
and ASCII.

Presents a dialog allowing insertion or deletion of bytes in a file while in HEX
editing mode.

Converts the selected text to upper case.

Converts the selected text to lower case.
Capitalize first character of each word in selected text.

Convert CR/LF's to Word Wrap for selected text.

Convert Word Wrap to hard CR/LF's for complete file.



View menu commands

The View menu offers the following commands:

Toolbar
Status Bar

Toggle
Bookmark

Next
Bookmark
Set Font
Set Printer
Font
Mirror

Display Font

Reset Fonts

(Default)

Shows or hides the toolbar.
Shows or hides the status bar.

Toggles a bookmark at the current line.
Move the cursor to the next bookmark.

Select the screen font to use.
Select the printer font to use.

Use display font for the printer.

Reset the screen and printer fonts to default settings.



Column menu commands

The Column menu offers the following commands:

Column Select column/block mode editing.

Mode

Insert/Fill Specify the text to insert into each column.
Columns

Delete Specify how many/which columns to delete.
Columns

Cut Specify how many/which columns to cut.
Columns

Insert Specify number range to insert into each row.

Number



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple
views of multiple documents in the application window:

Duplicate Creates a duplicate window that views the same
Window document.

Cascade Arranges windows in an overlapped fashion.

Tile_ Arranges windows in non-overlapped horizontal tiles.
Horizontal

Tile Arranges windows in non-overlapped vertical tiles.
Next Window Makes the next window active.

Previous Makes the previous window active.

Window

Arrange Arranges icons of closed windows.

Icons

Window 1 Goes to specified window.

2, ..




Help menu commands

The Help menu offers the following commands, which provide you assistance with this
application:

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)
Use this command to create a new document in UltraEdit.

You can open an existing document with the Open command.

Shortcuts

Toolbar:

Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document (file) in a new window. You can open multiple
documents at once. Use the Window menu to switch among the multiple open documents. See
Window 1, 2, ... command.

This command presents the File Open dialog. This allows multiple files to be selected and opened at
one time.

Files may also be opened by dragging them from the File Manager into UltraEdit's window and dropping
them. (Releasing the mouse button).

You can create new documents with the New command.

Shortcuts

Toolbar:

Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open. This box lists files with the extension you
select in the List Files of Type box.
List Files of Type
Select the type of file you want to open:
k >k

Drives
Select the drive in which UltraEdit finds the file that you want to open.
Directories
Select the directory in which UltraEdit finds the file that you want to open.
Read Only
Check this item to open a file in a read-only manner. Modifications will be disabled.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.

UltraEdit allows multiple files to be selected from the file list and opened at one time. To select multiple
files, select the first file from the list, then with the CTRL key pressed, select other files in the list. When
all files are selected, select OK and the selected files will be opened.

Files may also be opened by dragging them from the File Manager into UltraEdit's window and dropping
them. (Releasing the mouse button).



Close command (File menu)

Use this command to close all windows containing the active document. UltraEdit suggests
that you save changes to your document before you close it. If you close a document
without saving, you lose all changes made since the last time you saved it. Before closing

an untitled document, UltraEdit displays the Save As dialog box and suggests that you name
and save the document.

You can also close a document by using the Close icon on the document's window, as shown
below:




Save command (File menu)

Use this command to save the active document to its current name and directory. When
you save a document for the first time, UltraEdit displays the Save As dialog box so you can
name your document. If you want to change the name and directory of an existing
document before you save it, choose the Save As command.

Shortcuts

Toolbar:

Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document. UltraEdit displays the Save As
dialog box so you can name your document.

To save a document with its existing name and directory, use the Save command.




File Save As dialog box

The following options allow you to specify the name and location of the file you're about to
save:
File Name
Type a new filename to save a document with a different name. A filename can contain
up to eight characters and an extension of up to three characters.
Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four
documents you closed. Choose the number that corresponds with the document you want

to open.



Exit command (File menu)

Use this command to end your UltraEdit session. You can also use the Close command on
the application Control menu. UltraEdit prompts you to save documents with unsaved
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.  UltraEdit supports
multiple levels of undo (the specific number varies based on the items being undone).
Repeated Undo commands will attempt to step backwards through the previous commands
and undo one at a time. The Redo command may be selected to redo a command that has
been undone. If commands are undone and then a new command is performed, the Redo
will nolonger allow previous undon actions to be redone.

Shortcuts
Keys: CTRL+Z or
ALT-BACKSPACE



Redo command (Edit menu)

The Redo command allows commands that have previously been undone with the Undo to
be redone. If commands are undone and then a new command is performed, the Redo
will nolonger allow previous undon actions to be redone.

Shortcuts
Keys: CTRL+A



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on
the clipboard. This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:

Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

E‘.
Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:

Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the

most common commands in UltraEdit, such as File Open. A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



The toolbar is displayed across the top of the application window, below the menu bar. The
toolbar provides quick mouse access to many tools used in UltraEdit.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document. UltraEdit displays the Open dialog box, in which you
can locate and open the desired file.

oy

&

Close an existing document. If the document has been modified, UltraEdit displays a
dialog asking if the changes should be saved.
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Save the active document or template with its current name. If you have not named
the document, UltraEdit displays the Save As dialog box.

Print the active document.
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Display the active document as it will be printed.

[

Insert a page break character into the file at the cursor position.

Toggle the Word-Wrap mode.

Toggle the HEX/ASCII editing mode.

Remove selected data from the document and stores it on the clipboard.
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Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Display the find dialog to search for a string.
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Repeat the last find command.
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Display the find and replace dialog.

Goto the specified line number or page break (or address in HEX mode).

Make the next document window active.

Make the next document window active.

Horizontally arrange multiple opened windows in a non-overlapped fashion.

Vertically arrange multiple opened windows in a non-overlapped fashion.

Cascade multiple opened windows in an overlapped fashion.

Display about box for UltraEdit.

Change the mouse pointer to a ? that displays help when clicked on an item.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be
executed by the selected menu item or depressed toolbar button, and keyboard latch state.
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the UltraEdit window. To display or hide the
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus. This area similarly shows messages that describe the actions of
toolbar buttons as you depress them, before releasing them. If after viewing the description
of the toolbar button command you wish not to execute the command, then release the
mouse button while the pointer is off the toolbar button.

The middle area of the status bar indicates line number (if enabled) of the cursor in the file,
the column number, the date and time the active file was last modified (prior to this
session), and the file size. For new files the date and time shown is the creation date and
time. The file size is updated when UltraEdit writes any changes to the disk.

The right areas of the status bar indicate which of the following keys are latched down:
Indicator Description

OVR The Overstrike mode is selected.
CAP The Caps Lock key is latched down.



Duplicate Window command (Window menu)

Use this command to open a new duplicate window with the same contents as the active
window. You can open multiple document windows to display different parts or views of a
document at the same time. If you change the contents in one window, all other windows
containing the same document reflect those changes. When you open a duplicate window,
it becomes the active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange lcons Command

Use this command to arrange the icons for minimized windows at the bottom of the main
window. If there is an open document window at the bottom of the main window, then
some or all of the icons may not be visible because they will be underneath this document
window.



1, 2, ... command (Window menu)

UltraEdit displays a list of currently open document windows at the bottom of the Window
menu. A check mark appears in front of the document name of the active window. Choose

a document from this list to make its window active.



Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can
jump to step-by-step instructions for using UltraEdit and various types of reference
information.

Once you open Help, you can click the Contents button whenever you want to return to the
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of
UltraEdit.



Context Help command

Use the Context Help command to obtain help on some portion of UltraEdit. When you
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and
question mark. Then click somewhere in the UltraEdit window, such as another Toolbar
button. The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

UltraEdit - <filename>

The title bar is located along the top of a window. It contains the name of the application
and document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside
the scroll bars indicate your vertical and horizontal location in the document. You can use
the mouse to scroll to other parts of the document.

The horizontal scroll bar is used to position within the current document. The vertical scroll
bar is used to change the horizontal viewing area of the document.

The horizontal scroll bar is not shown if WORDWRAP mode is selected.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

&

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer
to the border you want to move.

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or
dialog box with the arrow keys.

Note: This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



#Minimize command (application Control menu)
Use this command to reduce the UltraEdit window to an icon.

Shortcut

Mouse: Click the minimize icon E on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon E on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window. UltraEdit determines
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. UltraEdit determines
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time. You can close all windows at
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window
ALT+F4 closes the UltraEdit window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar. This option
does not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap. This option does not
affect applications reduced to icons.
Arrange Ilcons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

UltraEdit allows selection of fonts for the screen and printer. The selection of screen fonts
will also apply to the printer if the Mirror Display Font menu item is checked on the View
Menu. If this item is not checked, the printer fonts have been selected independently from
the screen fonts.

The Font dialog is presented when font selection is selected from the View Menu. It will be
presented if either the Set Font or the Set Printer Font is selected.

The Font dialog presents a selection of installed fonts that may be selected for use. If the
fonts are being selected for the printer, only fonts applicable to the printer are available.
Selection of font and font size is available.



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

This command displays a dialog box for searching the document for the specified text. In
addition to searching for printable characters, Tab characters and newline (Carriage
Return/Line Feed) characters may be searched for. To search for a Tab character, use "~t"
characters in the dialog. To search for the newline characters, use "~ p" characters in the
dialog. To search for a "~" character, use "~"" in the dialog.

Additionally, the characters "~ s" will be replaced with any text that is highlighted when a
find is executed and the characters "~ c" will be replaced with the contents of the clipboard
(upto 200 characters). This is useful particularly for macros. When recording a macro, the
option exists to include a find of a specified character string, or using "”~s" the macro
records the "~s" and when replayed will determine the text highlighted at the time the
macro is playing back, likewise when using "~ c", these characters will be replaced with the
contents of the clipboard at the time the macro is playing back.

The following search options exist:

Search Direction
The default search direction is down (toward the end of the document). The option to
search up or down the document is given. If a search has already occurred in the
document, the default search direction is that of the previous search.

Match Case
By default, the search will not be case sensitive. The option to make the search case
sensitive is given. If a search has already occurred in the document, the default selection
for case sensitivity is that of the previous search.

To select all text between the cursor position and the search target, hold down the SHIFT key at the time
the search is started with the FINDNEXT button.

If the editor active window is in HEX mode, an additional option exists:

ASCII
By default, in HEX mode, the search will be for hexadecimal characters. Optionally the
find may be configured to search for ASCIl characters.

When a find operation is complete the text is highlighted.

Shortcut
Keys: ALT+F3



Find Next command (Edit menu)

This command repeats the previous FIND command. The next occurrence of the find text will
be found (if present) in the same direction as the previous find command.

To select all text between the cursor position and the search target, hold down the SHIFT key at the time
the search is started with the FIND NEXT menu item or shortcut key.

Shortcut
Keys: F3
@Normal@



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

This command displays a dialog box for searching the document for the specified text, and
replacing it with a different text.

In addition to searching and replacing printable characters, Tab characters and newline
(Carriage Return/Line Feed) characters may be searched for or replaced. To specify a Tab
character, use ""t" characters in the dialog. To specify the newline characters, use "~ p"
characters in the dialog. To specify a "~" character, use "~"" in the dialog.

Additionally, the characters ""s" will be replaced with any text that is highlighted when a
find is executed and the characters "~ c" will be replaced with the contents of the clipboard
(upto 200 characters). This is useful particularly for macros. When recording a macro, the
option exists to include a find of a specified character string, or using "”~s" the macro
records the "~s" and when replayed will determine the text highlighted at the time the
macro is playing back, likewise when using "~ c", these characters will be replaced with the
contents of the clipboard at the time the macro is playing back.

The following replace options exist:

Find Next
Find next finds the next occurrence of the specified text.

Replace
Replace finds the next occurrence of the specified text and replaces it with the new text.

Replace All
Replace all finds every occurrence of the specified text and replaces each occurrence with the new
text.

Match Case
By default, the search will not be case sensitive. The option to make the search case
sensitive is given. If a search has already occurred in the document, the default selection
for case sensitivity is that of the previous search.

If the editor active window is in HEX mode, an additional option exists:

ASCII
By default, in HEX mode, the search will be for hexadecimal characters. Optionally the
find may be configured to search for ASCII characters.

When a find operation is complete the text is highlighted. In HEX mode additional characters may be
highlighted if the specified search string crosses a line. In this case, all characters displayed from the
first character of the search string on the first line to the last character of the search string on the last line
are highlighted. If a replace is requested, only the search string will be replaced.

Shortcut
Keys: CTRL+R



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out. The Repeat menu item
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should
modify a document using your application.

If your application supports multiple document types and you want to have a distinct help
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file
produced by AppWizard. Alternatively, run MAKEHM as follows:

makehm IDR_HIDR ,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOCI1TYPE help context i.d. used by this help topic for the
first document type supported by your application. AppWizard produces an alias in the .HPJ
file for your application, mapping HIDR_DOCI1TYPE to the HIDR_ produced by MAKEHM for
that document type. >>






No Help Available

No help is available for this area of the window.



No Help Available
No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each
AFX_HIDP_xxx value. For example, AFX_HIDP_INVALID_FILENAME is the help topic for the

Invalid Filename message box. >>






Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where
you may specify the range of pages to be printed, the number of copies, the destination
printer, and other printer setup options.

Shortcuts

Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection. Choose the Setup option to change the
printer and printer connection.

Setu

Digplays a Print Setup dialog box, so you can select a printer and printer connection.
Print Range

Specify the pages you want to print:

All Prints the entire document.

Selectio  Prints the currently selected text.

n

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer. The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When
you choose this command, the main window will be replaced with a print preview window in
which one or two pages will be displayed in their printed format. The print preview toolbar
offers you options to view either one or two pages at a time; move back and forth through
the document; zoom in and out of pages; and initiate a print job.




Print Preview toolbar

The print preview toolbar offers you the following options:

Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a
Print Setup dialog box, where you specify the printer and its connection.




Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific
Printer option and select one of the current installed printers shown in the box. You
install printers and configure ports using the Windows Control Panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.
Options
Displays a dialog box where you can make additional choices about printing, specific to
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



UltraEdit (UltraEdit-32) Help Index

How To ...
Set and Move to Bookmarks

Change Font Selection

Change Insert/Overstrike modes

Change Tab Settings

Drag and Drop files from the File Manager

Open Multiple Files at Once
Delete the active file

Edit in HEX mode

Indent Line Automatically
Load a Macro

Save a Macro

Record a Macro

Stop Recording a Macro

Playback a Macro
Select Next DocumentWindow

Select Previous DocumentWindow

Commands
File menu
Edit menu
View menu
Column menu
Macro menu

Options menu
Window menu

Help menu
Tool Bar Commands
Keyboard Commands

Right Mouse Button Commands

Command Line Parameters
Command Line



Macro menu commands
The Macro menu includes commands that let you record and playback macros, load and/or save a macro.
What is a macro?

A macro is a series of keystrokes or actions that have been 'recorded' in the order performed. A macro
allows you to 'record' a series of keystrokes or actions and then 'playback’ or repeat the recorded
keystrokes and/or actions. A macro is typically used to perform a similar set of actions, multiple times on
each occurrence of a given text string.

For more information, select the Macro menu command name.:

Load a Macro Loads a macro from a file.

Save a Macro Saves a macro to a file.

Record a Macro Starts recording a macro.

Stop Recording a Macro Stops recording a macro.

Playback a Macro Playback a macro.

Playback a Macro Playback a macro a defined number of times.

Multiple Times




Options menu commands

The Options menu provides access to the configuration dialog. The configuration dialog is a
"Tabbed" dialog with the following pages:

General ltems

Tab Settings
File Types



Macro Load (Macro menu)

The Macro Load command presents a dialog box for loading a previously saved macro from a disk file.
The dialog box allows selection of a file from any file device known to the system. The default file name
presented is UltraEdit. MAC, although any filename is acceptable.

When a file is selected for loading, a check is made to ensure the file is a UltraEdit macro file.



Macro Save (Macro menu)

The Macro Save command presents a dialog box for saving a macro that has been recorded using the
Macro Record command to a disk file. The dialog box allows selection of a file from any file device known
to the system. The default file name presented is UltraEdit. MAC, although any filename is acceptable.

This command is available only if a macro has been recorded, or loaded.



Macro Record (Macro menu)

The Macro Record command starts 'recording' keystrokes and actions for later playback. Recording is
stopped when the Stop Recording menu selection is made.

Notes for recording macros:

The Macro Record function records all keystrokes and characters typed while recording is selected. All
keystrokes are recorded, including key combinations that move to end of line, top or bottom of document
etc. Care should be taken to ensure that when the macro is to be Played back the same keystrokes are
appropriate.

Mouse motion and scrolling is NOT recorded while recording is selected. All positioning should be
performed with the keyboard.

Macros will record and playback the Next Window and Previous Window commands.

Find and Replace is supported while recording is selected (see Find for special characters that are useful
with macros). Any find or replace functions will be recorded directly as performed, unless using special
characters that are replaced when executing with the contents of the clipboard or the highlighted text, see
Find. If all, or any occurrences of "FIND" are replaced with "REPLACE" in a file, the same action will be
performed when the macro is Played back.

Cut, Copy and Paste are also supported while macro recording is selected. Any of these operations will
be performed dynamically as the macro is Played back. That is to say that if an item is cut while recording
the macro, an item will be cut while playing back the macro based on the selected text at the time the
macro is being played back. If the selected text is different while playing back the macro, from when the
macro is recorded, the text cut while playing back the macro will also be different.

This command is not available if a macro record session is already active.



Macro Stop Recording (Macro menu)

The Macro Stop Recording command stops capturing keystrokes and actions that was started when the
Macro Record function was selected. Once a macro has been recorded and the session has been
stopped with this command, the macro may be played back by selecting the Macro Play command.

After a macro has been recorded, it may by saved using the Macro Save command.

This command is not available if a macro record session is not active.



Macro Playback (Macro menu)

The Macro Playback command allows a macro that has been recorded with the Macro Record command
to be replayed. The macro is replayed one time for each invocation of the command. To replay the macro

multiple times use the Macro Playback Multiple Times command.

This command is not available if a macro record has not been recorded or loaded.



Macro Playback Multiple Times (Macro menu)

The Macro Playback Multiple Times command allows a macro that has been recorded with the Macro
Record command to be replayed multiple times. A dialog box is presented that prompts the user for a
number between 1 and 100000 that specifies the number of times the macro should be replayed. To
replay the macro a single time use the Macro Playback command.

This command is not available if a macro record has not been recorded or loaded.



Word Wrap command (General Configuration Page)

Use this command to automatically wrap words to the next line at the horizontal edge of the
active window. When active, word wrap will automatically insert a hidden carriage return at
the end of a line if it will not fit in the displayable area of the window.

If the editor active window is in HEX mode, this command is not available.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of
UltraEdit.



Setting and Moving to Bookmarks (View menu)

UltraEdit allows you to set a "bookmark" to mark a position in a file. Once a bookmark has been set at a
line, you may use menu or keyboard commands to move to that line.

To set a bookmark:

1. Move the cursor to the line where you want to set a bookmark.
2. From the View menu, choose Toggle Bookmark.
Shortcut

Keys: CTRL+F2
To move to the next bookmark after the insertion point, choose Next Bookmark from the View menu.
Shortcut

Keys: F2
@FootNote-HIpR@



Automatic Line Indentation (General Configuration Page)

UltraEdit provides automatic line indentation. This option is toggled on or off by selecting it from the Edit
menu. When automatic line indentation is enable, UltraEdit automatically indents a line to match the
indentation of the previous line. The indentation is performed by inserting spaces into the document.

This option is only active in INSERT mode, not in OVERSTRIKE mode.



Delete Active File command (File menu)

Use this command to close the active document and delete its associated file from the disk.
This command prompts the user to ensure the file should really be deleted. If the file is
deleted from the disk, it is no longer available. USE THIS COMMAND WITH CARE.



Hex Mode Editing (Edit menu)

The HEX Edit command selects the editing mode for the active window. The mode is toggled between
Hexadecimal (HEX) and ASCII. The ASCIl mode of editing is typically used for any ASCII (text) based
files. In the ASCIl mode, UltraEdit allows normal operation of all functions and allows any characters to be
typed.

The HEX mode of editing is typically used for non ASCII files, or binary files. These files typically contain
non-printable characters, and are not text files.

The following restrictions apply when HEX mode is selected:
Insert mode is not supported.

When the HEX mode of editing is selected for a given window, UltraEdit splits the screen area into three
areas as shown:

File Offset: Hexadecimal Representation ; ASCIl Representation
000000h: 3031 323334353637 38393031323334 35 :123456789012345

The file offset area shows the current byte offset of the character at the beginning of the line to
form the beginning of the file.

The hexadecimal representation, shows the hexadecimal value of each file byte as a two
character field, separated from the next byte by a space (' ).

The ASCII representation provides the view of printable characters. Non printable characters
are shown with a period character ('.").

Editing may be performed in the ASCII area, or the HEX area. Positioning from one area to the
other is performed by clicking the left mouse button in the appropriate area or by pressing the
TAB key. The TAB key switches the cursor between the ASCIl and HEX area and maintains
the character offset in the file. In the HEX area, the only valid characters are, 0-9, A-F, and a-
f. All other characters are invalid and are ignored. In the ASCII area, any printable character is
valid, and will be accepted with the exception of <CR> and ENTER.

Editing in either the ASCII are or the HEX area automatically updates the other area after each
valid character is typed.

All modifications are performed in OVERSTRIKE mode.
To insert or delete characters in HEX mode, use the HEX Insert/Delete selection from the Edit
menu.

Cut, copy and paste are supported in HEX mode.

Shortcut
Keys: CTRL+H






Insert/Overstrike Modes

UltraEdit allows editing in both insert and over strike modes. The mode of operation is indicated in the
status bar at the bottom of the UltraEdit window. The insert/overstrike mode is changed with the INSERT
key. The mode is toggled when the INSERT key is pressed.

If insert mode is selected, the second area of the status bar is clear, if overstrike mode is selected, the
second area of the status bar shows 'OVR'.

Insert mode causes a key to be inserted into the document at the position of the cursor. Overstrike mode
causes the character immediately to the right of the cursor to be overwritten by the new character.

If the editor active window is in HEX mode, the active window is always in overstrike mode. To insert text
in HEX mode, use the HEX Insert/Delete selection from the Edit menu.



Tab Settings (Tab Configuration Page)

UltraEdit allows for selection of TAB stops and for TAB characters to be replaced by spaces automatically
while editing. The tab settings menu item under the edit menu displays a dialog that has two items that
may be modified.

The first item, if checked instructs UltraEdit to replace TAB characters with spaces. If this selection is
made, the second item allows selection of the number of spaces to use.

The second item specifies the TAB stops, or the number of spaces to use in place of a TAB character.

If the option to replace TABs with spaces is chosen, UltraEdit inserts spaces in place of TABS but
maintains the TAB stop spacing using the number of spaces specified.

UltraEdit does not replace existing TAB characters that may exist within the document.



Set Font (View menu)

The Set Font menu item presents the Choose Font dialog box that allows selection of
different fonts and font sizes. The selection made will apply to the screen fonts and will also
be applied to the printer font if the Mirror Display Font menu item is checked on the View
Menu. If this item is not checked, the printer fonts have been selected independently from
the screen fonts.

Font selections may be reset to default values by selecting the Reset Fonts menu item.

Note: If the printer does not support the font, Windows automatically adjusts to the
closest font.



Set Printer Font (View menu)

The Set Printer Font menu item presents the Choose Font dialog box that allows selection of
different fonts and font sizes for use by the printer. The selection made will apply only to
the printer fonts. Selection of the printer fonts unchecks the Mirror Display Font menu item
on the View Menu. Only fonts applicable to the printer will be available.

Font selections may be reset to default values by selecting the Reset Fonts menu item.



Mirror Display Font (View menu)

The Mirror Display Font menu item instructs UltraEdit to use the font that is selected for the
screen on the printer. This overrides any font selection already made for the printer with

the Set Printer Font menu item.



Reset Fonts (Default) (View menu)

The Reset Font menu item instructs UltraEdit to reset user selections of the screen and
printer fonts to the default settings. Any user selections of the screen fonts made with the
Set Font menu item or printer fonts made with the Set Printer Font menu item will be lost.



Add Indents (Edit menu)

The Add Indents menu item presents a dialog that allows the user to specify the number of
spaces to add at the beginning of each of the selected (highlighted) lines. UltraEdit starts
adding the specified number of spaces to each line beginning with the first highlighted line
and ending with the last line that has at least one character selected (highlighted).

The Indents will be added to all lines stated above, irrespective to and indentations that
may already exist.

To remove indentations, use the Remove Indents menu item on the Edit Menu.




Remove Indents (Edit menu)

The Remove Indents menu item presents a dialog that allows the user to specify the number
of spaces or tabs remove from the beginning of each of the selected (highlighted) lines. If
the checkbox specifying removal of all indents is checked, UltraEdit will remove ALL
indentation at the beginning of the selected lines. UltraEdit starts removing the indents
beginning with the first highlighted line and ending with the last line that has at least one
character selected (highlighted).

If no indentation is found at the beginning of a selected line, no changes are made to that
line.

To add indentations, use the Add Indents menu item on the Edit Menu.



Hex Insert/Delete (Edit menu)

The HEX Insert/Delete command allows the insertion or removal of characters at the current cursor
position while in the HEX mode. This command presents a dialog that allows selection to insert or delete
characters and requires the number of characters that are to be inserted or deleted to be specified.

If insert is selected, UltraEdit will insert the specified number of characters in the file and initialize them to
a hexadecimal value of 20 (ASCII space). The characters may them be modified as required.

If delete is selected, the specified number of characters will be removed from the file beginning at the
cursor position.

Shortcut
Keys: CTRL+D



Disable Line numbers (General Configuration Page)

The Disable Line Numbers option allows the line number display in the status bar to be disabled. Under
normal circumstances this option should be left unchecked. For very large files, file positioning may be
slowed down while UltraEdit establishes the line number. In this case the line numbers may be disabled.

If the option is checked, line numbsers are disabled, if unchecked line numbers are enabled.



Drag and Drop

UltraEdit supports dragging and dropping files from the File Manager into an open session of UltraEdit.
Files may be selected from the File Manager (multiple files may be selected) and dragged into the
UltraEdit window. If the mouse button is released with the mouse over UltraEdit's window the files
selected will automatically be opened for editing with UltraEdit.



Command Line Parameters

UltraEdit supports command line parameters specifing files to be opened. UltraEdit allows multiple files
to be specified in the command line. Each of the files specified will be opened when UltraEdit starts up.
The filenames on the command line should be separated with a space (' ').

UltraEdit accepts a '/P' or '/p' on the command line. This instructs UltraEdit to print the files that appear
on the command line automatically and to exit when the files have been printed.



Page Setup (File menu)

The Page Setup menu item presents a dialog allowing the user to set up page headers, footers and
margins for printing. The page header, if setup, is printed at the top of every page. The page footer, if
setup, is printed at the bottom of every page. If a page footer or header is setup, a single line is printed
across the page between the header or footer and the text to be printed.

The header or footer may be disabled by selecting the appropriate check box.

The page header and footer may include text defined by the user, and additionally special characters to
allow the filename, and page numbers to be printed in the header or footer.

The special characters are:

&f This is replaced in the header or footer with the filename.
&p This is replaced in the header or footer with the page number.

Additionally, the header or footer may include the file date and time or system date and time. Two radio
buttons allow the selection of either the file date, or the system date to be included in the header or footer.
The radio buttons select the source of the date and time, additional special characters used in the
header or footer specify if the date and time are to be printed and what format is used.

The characters used to specify the time and date format are shown below, the absence of any of these
characters result in the time and date not being printed.

The formatting codes date and time are listed below:

Format Description

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%c Date and time representation appropriate for the locale

%d Day of the month as a decimal number (01-31)

%H Hour in 24-hour format (00-23)

%l Hour in 12-hour format (01-12)

Y%j Day of the year as a decimal number (001-366)

%m Month as a decimal number (01-12)

%M Minute as a decimal number (00-59)

%p Current locale's AM/PM indicator for a 12-hour clock

%S Second as a decimal number (00-59)

%U Week of the year as a decimal number, with Sunday as the first day of the week (00-51)
Y%w Weekday as a decimal number (0-6; Sunday is 0)

%W Week of the year as a decimal number, with Monday as the first day of the week (00-51)
%X Date representation for current locale

%X Time representation for current locale

%y Year without the century as a decimal number (00-99)

%Y Year with the century as a decimal number

%Z Time zone name or abbreviation; no characters if time zone is unknown
%% Percent sign

Examples:



Date is July, 4th 1994. Time is 9:00pm
"%X , %x" prints "21:00, 07/04/94"

Date is July, 4th 1994. Time is 9:00pm
"%c" prints 07/04/94 21:00

Date is Jan, 10th 1991. Time is 5:00am
"%A, %B %d, %Y %I:%M%p" prints Tuesday, January 10, 1991 05:00:am

Page Margins
The page margins may be set up in either inches or millimeters (mm). Each margin, top, bottom, left and

right may be set independently. The margins are applied before the headers and footers are generated.
If the printer is set up to have a minimum margin that is greater than the margin selected in UltraEdit the
printer margin will be in effect.

Page Break Character
The page break character may be set to any ASCII character. The page break character defaults to a

form-feed character ,12 (0C HEX). This character may be changed if required but should not be set to
any printable character as a page break will be inserted on every occurrence of this character when
printing occurs. It may be desirable to change this character if the font being used does not allow the
page break character to be seen.



Goto Line/Page (Edit menu)

The Goto menu item presents a dialog that allows the user to specify the line or page break at which the
cursor should be positioned. The cursor is positioned at the line specified and the line is scrolled into
view. If the line number is greater than the number of lines in the file, the cursor is positioned at the end
of the file.

When Page Break is specified, the cursor is positioned at the line with the specified page break character.

In HEX mode the goto dialog allows the user to select the offset into the file at which the cursor should be
positioned. If the offset is greater than the file size, the cursor is positioned at the end of the file.

Shortcut
Keys: CTRL+G



Insert Page Break (Edit menu)

The Insert Page Break menu item inserts a page break character at the current cursor position. The
page break character can be configured in the Page Setup dialog.

When the document is printed, the page break character is replaced with a page break. Printing
continues on the next page following a page break character.



Generate Backup File (General Configuration Page)

The Generate Backup File menu item determines if UltraEdit will copy the original file to a backup file
when changes are saved. If this item is checked UltraEdit will copy the original file to a file with the same
name and a ".BAK" extension when the file is saved. If this item is not checked, a backup file will not be
generated.



Keyboard Commands

UltraEdit allows the use of keyboard commands for a number of commonly used features.

commands are listed below:

F1
Shift+F1
Ctrl+N
Ctrl+O
Ctri+F4
Ctrl+S
Ctri+P
Ctrl+X
Ctri+C
Ctrl+V

Ctrl+zZ

Ctrl+A

Alt+F3

F3

Ctri+R

Ctrl+G

Ctrl+F5

ALT+F5

F5

ALT+C
Ctri+Backspace
INS

Ctrl+H

Ctrl+D

Ctrl+F2

F2

Ctri+M

Ctri+L

Ctrl+F6
Ctrl+Shift+F6
Alt+F4
Ctri+Alt+A
Ctri+Alt+Shift+A
Ctrl+Alt+O
Ctrl+Alt+Shift+O
Ctri+Alt+U
Ctrl+Alt+Shift+U
Ctri+Alt+S
Ctrl+Alt+Shift+S

Help
Context Help
File New
File Open
File Close
File Save
File Print
Edit Cut

Edit Copy
Edit Paste

Edit Undo
Edit Redo
Edit Find

Edit Find Next
Edit Replace
Edit Goto

Edit To Lower
Edit To Upper

Edit Capitalize
Column Mode

Delete previous word
Insert/Overstrike Mode
HEX Edit

HEX Insert/Delete

Set Bookmark

Goto Bookmark

Macro Play

Macro Play Multiple Times
Next Window

Previous Window
Exit UltraEdit
Inserts & character
Inserts A character
Inserts 6 character
Inserts O character
Inserts U character
Inserts U character
Inserts R character
Inserts R character

The keyboard

Show UltraEdit help

Invoke the context help command and cursor.
Create a new document file

Open an existing document file

Close an existing document file

Save the active document

Print the active document

Cut text from the document into the clipboard
Copy text from the document into the clipboard
Paste text from the clipboard into the active
document

Undo the last action if possible

Reverse the last Undo action if possible

Find a character string

Repeat last find

Find and replace a character string with another
Goto the specified line (or HEX address)
Convert selected text to lower case

Convert selected text to Upper case

Capitalize first character of each word in selected text
Toggle column/block mode on and off

Delete the word preceding the cursor

Toggle between Insert and Overstrike mode
Toggle HEX editing mode

Insert or delete characters in HEX editing mode
Toggle bookmark on and off

Goto next bookmark

Replay a macro

Replay a macro the specified number of times
Make the next document window active

Make the previous document window active
Exit UltraEdit



UNIX/MAC to DOS (File menu)

Use this command to correct the end of line characters for display in UltraEdit and other text
editors.

Some documents generated from UNIX based systems (and some other systems) do not
terminate each line with a carriage return and linefeed. UltraEdit requires all lines to be
terminated with a carriage return and linefeed character.

This command searches the file for all carriage return and line feed characters. If a carriage
return character is found without an accompanying linefeed character, a line feed character
is added. If a linefeed character is found without a preceding carriage return character a
carriage return character is inserted. If a linefeed is found preceding a carriage return the
characters are reversed.

To convert a file to UNIX format, use the DOS to UNIX command.



To Upper Case (Edit menu)

This command changes all selected text to upper case. There is no limit on the amount of
text that may be selected.

Shortcut
Keys: ALT+F5

@Normal@



To Lower Case (Edit menu)

This command changes all selected text to lower case. There is no limit on the amount of
text that may be selected.

Shortcut
Keys: CTRL+F5

@Normal@



Capitalize (Edit menu)

This command changes the first letter of all words in the selected text to upper case and the
remaining letters to lower case. There is no limit on the amount of text that may be
selected.

Shortcut
Keys: F5



Right Mouse Button Commands
UltraEdit allows the right mouse button to display a pop-up menu.

If the right mouse button is clicked while in a document window, the Edit Menu is displayed at the position
of the mouse click. If the right mouse button is clicked while in the UltraEdit main window and outside of
a document window, the File Menu is displayed at the position of the mouse click.



Insert File (File menu)
Use this command to insert an existing document (file) into the active document.

This command presents a dialog allowing selection of the file to insert. The complete contents of the
selected file is inserted in the active document at the cursor position.



Convert CR/LF's to Wrap (Edit menu)

Use this command to remove the CR/LF (carriage return/line feed) characters from the file allowing the
text to be Word Wrapped by UltraEdit. This feature removes all CR/LF characters for text that is
selected. If no text is selected this function has no effect.

To remove all CR/LF characters from the file select the complete file. To do this, position the cursor at
the beginning of the file and press CTRL+SHIFT+END at the same time.

To add CRI/LF (carriage return/line feed) characters to the file use the
Convert Wrap to CR/LF's command.



Convert Wrap to CR/LF's (Edit menu)

Use this command to Word Wrap the text based on either the width of the display window or a specified
column number and write CR/LF (carriage return/line feed) characters to the file. If a space is found at
the position of the wrap a single space is removed. This allows the document to be saved as viewed in
the word wrap state with CR/LF characters inserted at the end of each word wrapped line.

When this item is selected, a dialog box is displayed allowing selection of the wrap parameters. By
default, the text will be wrapped based on the current view. That is to say, the text will be wrapped at the
window boundary as shown on the screen. This dialog allows selection of a column number at which the
text should be wrapped. In this case the text will be wrapped at the specified column or at the preceding
word boundary on the line.

This feature works on the complete file irrespective of any text that may be selected.

To remove CR/LF (carriage return/line feed) characters from the file use the Convert CR/LF's to Wrap
command.



Multiple Instances (General Configuration Page)

The Multiple Instances menu item determines if UltraEdit opens another instance of UltraEdit if it is
invoked when a copy is already active. If this option is enabled, a new instance is opened each time
EditPro is invoked. If this option is not enabled, only a single instance of UltraEdit is opened, and any
additional requests result in the first instance becoming active with the new file loaded in addition to any
files already open.



Save All command (File menu)

Use this command to save all modified documents to its current name and directory. When you save a
document for the first time, UltraEdit displays the Save As dialog box so you can name your document. If
you want to change the name and directory of an existing document before you save it, choose the Save

As command.



Column Mode (Column menu)

This command changes the operation of the editor for selecting text. When column mode is selected
highlighted text is based on the character column position of the first character selected to the column of
the last character of text selected. Text selected in this mode does not automatically include all text
between the start and end position, but includes all text in the columns between the first and last
character selected.

Column mode editing is sometimes referred to as block mode editing as the act of selecting text forms a
rectangle.

®)

ut, Copy and Paste work with the selected text.

Column mode editing requires the Word Wrap be turned off and a fixed pitch font be selected.

When column mode is enabled, additional column features are enabled; Insert/Fill Columns, Delete
Columns, Cut Columns and Insert Number.

Shortcut
Keys: ALT+C



Insert/Fill Columns (Column menu)

This command presents a dialog that allows a text string to be entered. This text string will be inserted
into every row starting at the current cursor position and proceeding to the last row of the file. The text
string will be inserted into every row at the column position indicated by the cursor when this command is
invoked. If text does not exist at this column in any row, spaces'' will be added to pad the row allowing
the text to be inserted correctly.

If at the invocation of this command, text is highlighted, the columns indicated by the highlighted text will
be replaced with the specified text.



Delete Columns (Column menu)

This command presents a dialog that allows the number of columns to be deleted to be specified. The
columns will be deleted from the file from every row starting at the current cursor position and proceeding
to the last row of the file. If a value of zero '0' is entered, columns will be deleted based on the
highlighted text when this command is invoked. This command does not save the deleted text in the
clipboard.



Cut Columns (Column menu)

This command presents a dialog that allows the number of columns to be cut to be specified. The
columns will be removed from the file from every row starting at the current cursor position and
proceeding to the last row of the file. If a value of zero '0' is entered, columns will be removed based on
the highlighted text when this command is invoked. This command saves the removed text in the
clipboard.



Insert Number (Column menu)

This command allows a sequential number to be inserted into very line at the column position indicated by
the cursor. This command presents a dialog that allows the initial value to be entered and the increment
for each line. This provides an easy method to add line numbers into a text file.

If any text is highlighted at the invocation of this command, the highlighted text will be replaced by the
inserted line numbers. The spacing required for the line numbers is calculated automatically based on
the number of lines in the file, the initial value and the increment. All numbers must be positive integers.



Find In Files command (Edit menu)

This command displays a dialog box for searching for a text string in files on a disk. You can specify the
string to search for and the files to search. Valid filenames may include wildcard characters, so to search
all text files with the extension "*.txt" you may specify "path\*.txt" where path is the drive and full directory
path to the files. You may also select to search files in sub directories.

The following search options exist:

Match Case
By default, the search will not be case sensitive. The option to make the search case sensitive is
given.

Search Sub directories
By default, only files specified in the specified directory are searched. This instructs the search to
search all sub directories of the specified directory.

When the find is executed, a new file window is opened (if it does not already exist) with the title "Find
Results". This windows is updated with each occurrence of the found string and the line number of the
file in which it was found. This window may be saved, printed, or edited in the same manner as any file.

Successive finds update an existing "Find Results" window if it already exists, or creates a new window if
it does not. If the window already exists, results are appended to the end.



Select All command (Edit menu)

This command selects (highlights) all the text in the current document.



Select Line command (Edit menu)

This command selects (highlights) the current line of text.



General Configuration Page

The general options page has the following selections:

Disable Line Numbers Disables line number display. This improves speed on large files.

Auto Indent Toggles the state of automatic line indentation for UltraEdit.

Allow Positioning This option allows the cursor to be positioned beyond the end text in a line.
Beyond Line End

Word Wrap Toggle state of word wrap for the current window.

Multiple Instances If checked, allow multiple instances of UltraEdit.

Generate Backup If checked, generate a backup file when document is saved.

File

Use Large Icons On If checked, large icons are used on the tool bar. This option is only read at
Tool Bar startup.



File Type Configuration Page

This page allows the list of file types that appear in the File Open and File Save As dialog boxes to be
configured. Upto 10 file types may be configured. These file types will be shown in the file operation
dialog boxes in the same order they are shown on this page.

Each file type configured consists of a file name and file description. The file name may (and probably
does) include wildcard characters and may include multiple file extensions each separated by a

semicolon ";"(i.e. "*.C;*.cpp"). The file description is a text field describing the file types.

This dialog also provides a DEFAULT button that resets the file types to the initial settings.



DOS to UNIX (File menu)

Use this command to convert the file to a UNIX format. This will replace the carriage return
and line feed combinations to a line feed only.

To convert a file from UNIX or MAC format, use the UNIX/MAC to DOS command.







